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Overview: New to Word? 

Do you need to use Word 2007, but 

you’re not quite sure how to get 

started? 

This course is designed to help you 

learn the basics of creating your first 

document. 

You’ll find out how to type where you 

want to on a page, fix spelling errors, 

change spacing and page margins, 

and save your work.
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Course goals

• Create and save a document. 

• Accept or reject suggested revisions for spelling and 

grammar as you type. 

• Change page margins. 

• Adjust spacing by deleting any extra spaces between 

words or extra lines between paragraphs. 



Lesson 1

Meet the document
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Meet the document

When you open Word, 

you see a blank 

document. 

It looks like a sheet of 

paper and takes up 

most of the screen 

space.

You need to get to work, but being new to Word, you 

may wonder how to get started. 

Let’s begin by helping you get comfortable with some 

Word basics. 
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Just start typing

Start with the Ribbon

and the cursor.  

1

2

Above the document, the Ribbon spans the top of Word. 

You use buttons and commands on the Ribbon to tell 

Word what you want to do. 

Word waits for you to start typing. The cursor, a blinking 

vertical line in the upper-left corner of the page, shows 

where the content you type appears on the page. 
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Just start typing

Start with the Ribbon

and the cursor.  

If you’d like to start typing further down the page instead 

of at the top, press the ENTER key on your keyboard 

until the cursor is where you want to type.

If you want to indent the first line you type, press the 

TAB key on your keyboard before you start to type. This 

will move the cursor one-half inch to the right. 
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Just start typing

Start with the Ribbon

and the cursor.  

As you type, the cursor moves to the right. When you 

get to the end of a line on the right side of the page, just 

continue to type. Word will move on to the next line for 

you as you type.

To start a new paragraph, press ENTER. 
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What’s that? 

Imagine that you’ve 

typed a few 

paragraphs. 

They seem far apart, 

and the second 

paragraph starts 

farther to the right 

than the first.

You can see what’s going on by looking at the formatting 

marks Word automatically inserts as you type. 

These marks are always in documents, but they are 

invisible until you display them. 
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What’s that? 

To see formatting 

marks, use the 

Ribbon, at the top of 

the window. 

On the Home tab, in the Paragraph group, click the 

Show/Hide button       . Click the button again to hide 

formatting marks.

These marks aren’t just for show. You can get rid of 

extra spacing by deleting extra marks. 
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What’s that? 

So what are formatting 

marks, and what do 

they mean? The 

picture shows a few 

examples. 

1

2
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Extra paragraph mark: ENTER was pressed twice.

Extra tab mark: TAB was pressed twice, making the 

second paragraph indented more than the first. 

Extra space between words: The SPACEBAR was 

pressed twice instead of once. 
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What are those underlines in my document?

As you type, Word 

might on occasion 

insert a wavy red, 

green, or blue 

underline beneath 

text. 

• Red: Indicates either a possible spelling error or that 

Word doesn’t recognize a word, such as a proper 

name or place. 

• Green: Word thinks grammar should be revised. 

• Blue: A word is spelled correctly but does not seem to 

be the correct word for the sentence. 
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What are those underlines in my document?

The picture shows an 

example of what you 

can do about the wavy 

underlines, in this 

case, red for spelling. 

Right-click the underlined word to see suggested 

revisions (every once in a while Word may not have any 

alternate spellings). 

Click a revision to replace the word in the document and 

get rid of the underlines.
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Change page margins

Page margins are the 

blank spaces around 

the edges of the page. 

There is a 1-inch 

(2.54-cm) page 

margin at the top, 

bottom, left, and right 

sides of the page. 

But if you want different margins, you should know how 

to change them, which you can at any time. 

When you type a very brief letter, for example, or a 

recipe, an invitation, or a poem, you might like different 

margins. 
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Change page margins

To change margins, 

use the Ribbon at the 

top of the window. 

Click the Page Layout tab. In the Page Setup group, 

click Margins. 

You’ll see different margin sizes, shown in little pictures 

(icons), along with the measurements for each of the 

margins. 
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Change page margins

The first margin in the 

list is Normal, the 

current margin. 

To get narrower margins, click Narrow. If you want the 

left and right margins to be much wider, click Wide. 

When you click the margin type that you want, your 

entire document automatically changes to the margin 

type you selected. 
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Save your work

By now you may have 

a finely tuned 

sentence or several 

paragraphs that you’d 

regret losing if your 

cat jumped on your 

keyboard, or if a 

power failure shut 

your computer off.
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Click the Microsoft Office Button in the upper-left 

corner of the window. 

To keep your work, you must save it. It’s never too early. 

Click Save. A dialog box opens, where you tell Word 

where you want to store the document on your computer 

and what you want to call it. 
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Save your work

After you save your 

document, and you 

continue to type, save 

your work as you go. 

Every once in a while, click the Save button      on the 

Quick Access Toolbar in the upper-left corner of the 

window. 
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Save your work

After you save your 

document, and you 

continue to type, save 

your work as you go. 

When you are through with the document and have 

saved your work, close the file. Click the Microsoft 

Office Button, and then click Close. 
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Suggestions for practice

1. Turn formatting marks on. 

2. Do some typing in your document. 

3. Work with revision marks. 

4. Change page margins. 

5. Save your document. 
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Make changes to your document
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Overview: Moving, selecting, and getting around

Have you created a Word document 

and then wondered how to make 

changes to it?

In this course, you’ll learn how to get 

from one place to another in a 

document so that you can make 

changes anywhere on the page. 

Then you’ll learn how to add and 

delete text and move it around. 
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Course goals

• Move the cursor around a document, using either the 

mouse or the keyboard, so that you can get to where you 

need to in order to make changes. 

• Select text to make revisions. 

• Move text by cutting and pasting.
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Make changes to your document

Documents get 

changed. 

You may make 

changes as you type, 

or after you finish the 

document. 

To work quickly and efficiently in the document, you 

need to know how to move around. 

Once you get to the part of the document you want to 

edit, you’ll need to type the new text you want to add, 

or select the existing text so that you can change or 

delete it. 
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Move around the document

Imagine that you want 

to type a new 

sentence between 

“civilization” and 

“During”: “Symphonies 

and constellations 

have been named for 

clocks.” 
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The cursor is the vertical line at the end of the second 

paragraph, in front of the paragraph mark.

You can move the cursor to the first paragraph by 

moving the pointer and then clicking, or by using the 

keyboard. 

To type where you want, first move the cursor:
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Select and delete text

After adding the 

sentence to the first 

paragraph, you read 

the paragraph. 

You think the second 

sentence will read 

better if you delete the 

word “really.”

To delete text, first select what you want to delete. You 

can do this by using the mouse or the keyboard. 

Once “really” is selected, delete the word by pressing 

DELETE on your keyboard. 
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Select and delete text

In the picture, you can 

see formatting marks: 

a dot  between each 

word and sentence, 

and a paragraph mark  

at the end of each 

paragraph. 

These marks help you when you revise text. 

For example, you don’t want to delete the space 

between words or sentences. One dot between each 

word or sentence lets you know that the spacing is okay. 
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Move text

Still looking at the first 

paragraph, you decide 

that the sentence you 

added should be the 

last sentence in the 

paragraph.

You don’t have to delete the sentence and then type it 

again. 

Instead, you can move the sentence by performing a 

cut-and-paste operation: Cut the sentence to delete it 

from its current location, and then paste it into the new 

location. 
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Move text

The picture illustrates 

what to do. 
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First select the entire sentence. 

Then, on the Ribbon at the top of the window, on the 

Home tab, in the Clipboard group, click Cut      .
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Move text

The picture illustrates 

what to do. 

3 Move the pointer to the end of the paragraph, where you 

want the sentence to appear (after the dot     formatting 

mark).

4 On the Home tab, in the Clipboard group, click Paste      . 

The sentence is pasted in place. 
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Undo changes

You’ve moved the 

sentence, but now 

you’re not happy with 

the change. 

Fortunately, you don’t 

have to go through the 

cut-and-paste process 

again to move the 

sentence back. 

1 On the Quick Access Toolbar at the very top of the 

window, click the arrow on the Undo button       .

Instead, use Undo: 
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Undo changes

You’ve moved the 

sentence, but now 

you’re not happy with 

the change. 

Fortunately, you don’t 

have to go through the 

cut-and-paste process 

again to move the 

sentence back. 

2

Instead, use Undo: 

Move the cursor over the last two actions, Paste and 

Cut, and then click. This will undo the last two actions 

you took and place the sentence back in its original 

location. 
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Use the scroll bar to review a document

Perhaps you have a 

long document that 

you’d like to read all 

the way through 

without having to 

continuously press the 

arrow keys to move 

the cursor. 

1
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The scroll bar is on the right side of the window,

To use it, click the scroll box, and then drag it up or down 

to move through a document without moving the cursor. 

You can do that by scrolling, using the scroll bar.
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Use the scroll bar to review a document

Perhaps you have a 

long document that 

you’d like to read all 

the way through 

without having to 

continuously press the 

arrow keys to move 

the cursor. 

3 Or click the single scroll arrows at either end of the scroll 

bar to move up or down. 

You can do that by scrolling, using the scroll bar.
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Use the scroll bar to review a document

Perhaps you have a 

long document that 

you’d like to read all 

the way through 

without having to 

continuously press the 

arrow keys to move 

the cursor. 

To quickly scroll by using your keyboard, press PAGE 

UP       to go up one screen or PAGE DOWN       to go 

down one screen. 
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Suggestions for practice

1. Show formatting marks.

2. Move around in the document.

3. Select text. 

4. Move text. 


